Creating Dimensions

A precise drawing plotted to scale often does not convey enough information for builders to construct your design. Usually you add annotation showing object measurements and the distances and angles between objects.

Dimensioning is the process of adding measurement annotation to a drawing. AutoCAD® provides many ways to dimension objects and many ways to format dimensions. You can create dimensions for a wide variety of object shapes in many different orientations. You can create dimension styles to format dimensions quickly and ensure that dimensions in your drawing conform to industry or project standards.
Dimensioning Concepts

Design is often divided into four phases: drawing, annotating, viewing, and plotting. During annotation, the designer adds text, numbers, and other symbols to communicate such information as the size and materials of design elements or notes for constructing the design. Dimensions are a common drawing annotation; they show object measurements such as a wall length, cylinder diameter, or building site area.

AutoCAD provides many dimension types and many ways to format them. You can specify measurements for all drawing objects and shapes. You can measure vertical and horizontal distances, angles, diameters, and radii. You can create a series of dimensions measured from a common baseline or create a series of dimensions measured incrementally. The following illustration shows examples of dimensions you can create.

Dimension Elements

Although dimensions may vary in type and appearance, most dimensions include dimension text, dimension lines, extension lines, and arrowheads.

- Dimension Text
  Indicates the actual measurement. You can use the measurement computed automatically by AutoCAD, supply your own text, or suppress the text entirely. If you use the generated text, you can append plus/minus tolerances, prefixes, and suffixes.

- Dimension Lines
  Indicates the extent of a dimension. Dimension lines usually have arrowheads at the end to indicate the dimension start points and endpoints. The dimension text is placed along the dimension line, which is often divided into two
Dimensioning Concepts

AutoCAD usually places dimension lines inside the measured area. If space is not sufficient, AutoCAD may move the dimension lines or text outside the measured area, depending on the placement rules set for the dimension style (see “Fitting Dimension Text and Arrowheads” on page 421). For angular dimensions, the dimension line is an arc.

Arrowheads

Displayed at the end of dimension lines to indicate where the measurement begins and ends. AutoCAD uses the closed filled arrowhead symbol by default. However, AutoCAD provides many other symbols that you can use, including architectural ticks, oblique strokes, dots, and slashes. You can also create your own symbols.

Extension Lines

Extend from the dimensioned object to the dimension line. Extension lines are drawn perpendicular to the dimension line, though you can make them oblique.

Center Mark

Marks the center of a circle or arc. Centerlines extend from the center mark. You can use a center mark only, or a center mark and centerlines.
Creating Dimensions

AutoCAD provides 11 dimensions that you can use to measure design objects. To start a dimension, you can use the Dimension menu or toolbar or enter a dimension command on the command line. To display the Dimension toolbar, right-click the Standard toolbar and choose Dimensions.

The following table lists the AutoCAD dimensions and common methods for starting dimensions. As you create dimensions, you probably will use more than one method, based on your experience, personal preference, or design tasks.

### AutoCAD dimensions and methods

<table>
<thead>
<tr>
<th>Menu</th>
<th>Toolbar button</th>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Linear</td>
<td><img src="image" alt="Linear" /></td>
<td>DIMLINEAR</td>
<td>Measures a straight-line distance. Includes options to create horizontal, vertical, or rotated linear dimension.</td>
</tr>
<tr>
<td>Aligned</td>
<td><img src="image" alt="Aligned" /></td>
<td>DIMALIGNED</td>
<td>Creates a linear dimension with the dimension line parallel to the extension line origin points. The dimension creates a true-length measurement of the object.</td>
</tr>
<tr>
<td>Ordinate</td>
<td><img src="image" alt="Ordinate" /></td>
<td>DIMORDINATE</td>
<td>Creates a dimension showing a point’s X or Y ordinate measured from a given origin point.</td>
</tr>
<tr>
<td>Radius</td>
<td><img src="image" alt="Radius" /></td>
<td>DIMRADIUS</td>
<td>Measures the radius of circles and arcs.</td>
</tr>
<tr>
<td>Diameter</td>
<td><img src="image" alt="Diameter" /></td>
<td>DIMDIAMETER</td>
<td>Measures the diameter of circles and arcs.</td>
</tr>
<tr>
<td>Angular</td>
<td><img src="image" alt="Angular" /></td>
<td>DIMANGULAR</td>
<td>Measures angles.</td>
</tr>
<tr>
<td>Baseline</td>
<td><img src="image" alt="Baseline" /></td>
<td>DIMBASELINE</td>
<td>Creates a series of linear, angular, or ordinate dimensions all measured from the same origin.</td>
</tr>
<tr>
<td>Continue</td>
<td><img src="image" alt="Continue" /></td>
<td>DIMCONTINUE</td>
<td>Creates a series of continued linear, aligned, angular, or ordinate dimensions, each created from the second extension line of the previous or last selected dimension and sharing a common dimension line.</td>
</tr>
</tbody>
</table>
Creating Linear Dimensions

Linear dimensions create distance measurements between two points in the XY plane of the current user coordinate system (UCS). You can specify the points or select an object. There are three types of linear dimension:

- **Horizontal**: Measures a distance between two points parallel to the X axis.
- **Vertical**: Measures a distance between two points parallel to the Y axis.
- **Rotated**: Measures a distance between two points at a specified orientation in the current UCS.

Although AutoCAD measures all three dimensions from the same points, the measurements differ because the linear distances are not the same.

When you start a linear dimension, AutoCAD creates a horizontal or vertical measurement automatically based on where you place the dimension. You can also specify the type of linear dimension explicitly.
To create a linear dimension

1. From the Dimension menu, choose Linear.
2. At the prompt, specify the first and second dimension points, or press ENTER and select an object to dimension.
3. Before you place the dimension, you can enter one of the following options to edit and position the dimension text.
   - To edit dimension text using the Multiline Text Editor, enter m.
     The angle brackets (<>), represent the calculated measurement. In the Multiline Text Editor, enter text before or after the angle brackets to add text before or after the dimension text. To replace the dimension text, delete the brackets, and then enter the new text. Choose OK.
   - To edit dimension text on the command line, enter t.
     The text you enter on the command line replaces the original text. Press ENTER to display the new text. To restore the original dimension text, enter t.
   - To rotate the dimension text, enter a, and then enter the text rotation angle.
   - To rotate the dimension, enter r, and then enter the dimension rotation angle.
   - To specify a horizontal or vertical dimension, enter h or v.
4. Specify the dimension line location.

   **Command line**  DIMLINEAR

**Creating Aligned Dimensions**

Use the aligned dimension (also called true length dimension) to create a linear dimension aligned with the dimension points. In the following aligned dimension illustration, point 1 indicates the object selection point, and point 2 indicates the dimension placement point.
To create an aligned dimension

1. From the Dimension menu, choose Aligned.
2. At the prompts, specify the first and second extension line origins, or press ENTER to select an object to dimension.
3. Before you place the dimension, you can edit its text or change the text angle.
   - Enter m to edit the dimension text using the Multiline Text Editor; enter t to edit the dimension text on the command line.
   - Enter a to rotate the angle of the dimension text.
4. Specify the dimension line location.

**Command line**  
DIMALIGNED

## Creating Ordinate Dimensions

Ordinate dimensions display the X or Y ordinate of any drawing point based on an origin point, called a *datum*. AutoCAD uses the origin of the current UCS to calculate each ordinate, or you can set a different origin. X-datum ordinate dimensions measure the distance of a point from the datum along the X axis. Y-datum ordinate dimensions measure the distance along the Y axis. AutoCAD aligns ordinate dimension text with the ordinate leader line.

To create an ordinate dimension

1. From the Dimension menu, choose Ordinate.
2. At the Select Feature prompt, use one of the following methods:
   - Specify the leader point to complete the dimension. The ordinate dimension changes from X-datum to Y-datum based on the relative distance from the origin.
   - To specify an X- or Y-datum ordinate explicitly, without regard to the leader position, choose X or Y, and then place the leader.
   - Enter m to edit the ordinate text using the Multiline Text Editor, or enter t to edit the dimension text on the command line.
   - Enter a to rotate the angle of the dimension text.

**Command line**  
DIMORDINATE

You can change the ordinate dimension datum either by moving the UCS or by using the datum point option of QDIM (see “Dimensioning Multiple Objects” on page 405). Changing the datum is useful for specifying ordinate dimensions at specific offsets to another object point, for example, to indicate holes in a part, or to set a series of coordinates from the corner of a building.
The following procedure creates a series of ordinate dimensions for a metal plate. To place the ordinate dimensions, you move the UCS and use object snaps (see “Snapping to Points on Objects” on page 167).

To set the datum point

1. From the Tools menu, choose Move UCS.
2. At the Specify New Origin Point prompt, enter int to use the Intersection object snap.
3. Select the lower-left corner of the box. This places the UCS origin at the selected intersection.
   You can now create ordinate dimensions for the circles based on the new origin. Before you begin, turn on Ortho mode (press Ortho on the status bar, or press F8) to help you create straight-line ordinate dimension leaders.

To identify the datum’s X ordinate

1. From the Dimension menu, choose Ordinate.
2. At the Select Feature prompt, enter int to use the Intersection object snap.
3. At the Of prompt, specify the lower-left corner of the plate.
4. Specify the ordinate leader endpoint, and then press ENTER.
   You can now use ordinate dimensions to show X and Y ordinates of the circle centers relative to the corner of the plate.

To identify the datum’s Y ordinate

1. From the Dimension menu, choose Ordinate.
2. At the Specify Feature Location prompt, enter int to use the Intersection object snap, or press SHIFT, right-click, and choose Intersection.
3. At the Of prompt, specify the lower-left corner of the plate.
4. Specify the ordinate leader endpoint.

To create ordinate dimensions

1. From the Dimension menu, choose Ordinate.
2. At the Select Feature prompt, enter cen to use the Center object snap.
3. Select the first circle to snap to its center.
4. Specify the leader endpoint.
5. Repeat steps 1 to 4 for the other two circles in the example.
Creating Radius and Diameter Dimensions

Use radius and diameter dimensions to measure the radius or diameter of circles and arcs.

To measure a radius or diameter

1. From the Dimension menu, choose Radius or Diameter.
2. Select a circle or arc.
3. Before you specify the dimension location, you can edit its text or change the text angle:
   - Enter `m` to edit the dimension text using the Multiline Text Editor, or enter `t` to edit the dimension text on the command line.
   - Enter `a` to rotate the angle of the dimension text.
4. Specify the dimension line location.

   **Command line** DIMRADIUS, DIMDIAMETER

Center marks or centerlines automatically display at the center of the arc or circle when you place a radius or diameter dimension outside the circle or arc. They do not display if you place the dimension inside the circle or arc, or if you turn off center marks. You can change the dimension fit and text placement options to force text and leader lines inside the circle or arc. See “Fitting Dimension Text and Arrowheads” on page 421.

Creating Center Marks and Centerlines

You can indicate the centers of circles and arcs using center marks and centerlines. You can also format the size of center marks and centerlines.

To create a center mark

1. From the Dimension menu, select Center Mark.
2. Select the circle or arc for which you want to create a center mark.

   **Command line** DIMCENTER
You format center marks on the Lines and Arrows tab of the Dimension Style dialog box. You can change the size of the center marks, and turn center mark and centerline display on and off. See “Formatting Dimension Lines and Arrows” on page 418.

Creating Angular Dimensions

Angular dimensions measure angles created by circles and arcs, angles between two lines, or angles created by three points.

To create an angular dimension

1. From the Dimension menu, choose Angular.
2. To specify the object you want to dimension, do one of the following:
   - Select a circle, and specify a second point on the circle.
   - Select an arc.
   - Select a line, and specify the second line.
   - Press ENTER, and specify the angle vertex and two points for the angle.
3. Before you set the dimension location, you can edit its text or text angle.
   - Enter m to edit the dimension text with the Multiline Text Editor, or enter t to edit the dimension text on the command line.
   - Enter a to rotate the angle of the dimension text.
4. Specify the dimension location.
   AutoCAD displays either the minor or the major angle, depending on where you place the dimension. To specify one or the other, move the cursor inside (minor) or outside (major) the extension lines.

Command line DIMANGULAR

If you use two straight, nonparallel lines to specify an angle, the dimension line arc spans the angle between the two lines. If the dimension line arc does not meet one or both of the lines, AutoCAD draws one or two extension lines to intersect the dimension line arc. The dimension line arc is always less than 180 degrees.

The following illustration shows examples of angular dimensions. Numbers indicate the first (1), second (2), and third (3) selection points.
Creating Baseline and Continued Dimensions

As you dimension your design, you may need to create a series of dimensions all measured from the same base or datum point, or several dimensions that add up to the total measurement. Baseline and continued dimensions help you accomplish both tasks. Baseline dimensions create a series of dimensions measured from the same dimension origin. Continued dimensions create a series of dimensions placed end to end. Each continued dimension begins at the second extension line of the previous one.

To create a baseline or continued dimension, you must first create (or select) a linear, ordinate, or angular dimension to serve as the base dimension. AutoCAD measures

- Baseline dimensions from the base dimension’s first extension line
- The first continued dimension from the base dimension’s second extension line and then each succeeding continued dimension from the second extension line of the previous one

The following illustration shows baseline dimensions.
To create a baseline dimension

1. Create (or select) a linear, ordinate, or angular dimension to serve as the base dimension.

2. From the Dimension menu, choose Baseline.
   AutoCAD uses the base dimension's first extension line as the origin.

3. Specify the second extension line location, and then continue to select extension line locations until you complete the baseline series.
   AutoCAD places the second dimension above the first at the baseline spacing specified in the Lines and Arrows tab of the Dimension Style dialog box (see “Formatting Dimension Lines and Arrows” on page 418).

4. Press ENTER.

5. If you want to create another baseline dimension series, choose a new base dimension and create the baseline dimensions. Otherwise press ENTER to exit the command.

When dimensioning a series of connected objects, use object snaps such as Endpoint and Intersection to precisely place baseline dimensions. You can also use Quick Dimension to dimension multiple objects (see “Dimensioning Multiple Objects” on page 405).

**Command line** DIMBASELINE

Creating continued dimensions is similar to creating baseline dimensions. However, though baseline dimensions are all based on the same dimension origin, AutoCAD uses each continued dimension’s second extension line as the origin for the next. The continued dimensions share a common dimension line, as shown in the following illustration.
To create a continued dimension
1 Create a base linear, ordinate, or angular dimension. The second point you specify is the origin for the first continued dimension.
2 From the Dimension menu, choose Continue. AutoCAD uses the second extension line of the base dimension as the origin and prompts you to place the second extension line point.
3 Specify the second extension line point.
4 Continue to select additional extension line origins until you complete the continued dimension series.
5 Press ENTER twice to end the command.

**Command line**  DIMCONTINUE

### Dimensioning Multiple Objects

You can use Quick Dimension to dimension multiple objects at one time. Using Quick Dimension, you can

- Quickly create arrangements of baseline, continued, staggered, and ordinate dimensions
- Quickly dimension multiple circles and arcs
- Edit existing dimension arrangements

**To dimension multiple objects**

1 From the Dimension menu, select QDIM.
2 Select the objects you want to dimension, and then press ENTER.
3 At the prompt, enter the dimension type, or press ENTER for the default.
4 Specify the dimension line location.

**Command line**  QDIM
To edit dimensions
1. From the Dimension menu, choose QDIM.
2. Select the dimensions you want to edit. To add or change dimensions, include the objects whose dimensions you want to include in the selection set.
3. At the prompt, enter e.
   AutoCAD places a cross at each eligible edit point.
4. To edit the points, do one of the following:
   - Select the points of the dimensions you want to remove.
   - Enter a, then specify the points you want to add.
5. Enter x to exit.
6. If the default dimension type is not the one you want, enter the letter of the dimension type at the prompt.
7. Specify a location for the new dimension arrangement.
8. Press ENTER.

Editing Dimensions

You can edit the placement of dimensions using AutoCAD editing commands, or you can use grips. Grip editing is the quickest and easiest way to modify dimensions. See “Editing with Grips” on page 246. Regardless of which method you use, dimensioned objects do not automatically change when you edit dimensions unless you include the objects in the edit selection set. Editing commands are available from the shortcut menu displayed when you right-click a dimension. You can also modify the format of dimensions by changing their properties using the Properties window or the Dimension Style Manager.

Every dimension has a set of definition points, small dots that are often covered by dimension lines or dimensioned object geometry. Definition points define the dimension location. Every definition point has a grip point, although not every grip point indicates a definition point. Therefore, if you use grips to edit dimensions, knowing the locations of definition points is not necessary. However, if you use commands to edit dimensions, you must include all the dimension’s definition points in the selection set.

To include definition points more easily, snap to them using the Node snap mode (see “Object Snap Descriptions” on page 171). The circles in the following illustration show the location of definition points for different dimensions.
NOTE  Definition points are drawn on a special DEFPOINTS layer, which is not plotted. DEFPOINTS are not affected by changes to the PDMODE (point display) and PDSIZE (point size) system variables.

Stretches Dimensions

You can use grips to stretch dimensions, or you can use the STRETCH command. If you use STRETCH, be sure to include the appropriate definition points in the crossing window selection set. For example, you can move dimension text by selecting and moving the dimension text grip. If you use STRETCH, use the crossing window to select the text. If you move the text outside the extension lines so that it no longer requires the dimension line to be split, the dimension line rejoins.
In the following illustration, the top vertex of the triangle is stretched downward. To stretch the vertical and horizontal dimensions at the same time, the definition points for the dimensions are included in the crossing selection window. While stretching does not change the dimension type (aligned, horizontal, or vertical), AutoCAD realigns and remeasures the aligned dimension and remeasures the vertical dimension.

To stretch a dimension

1. From the Modify menu, choose Stretch.
2. Use a crossing selection window to select the dimension(s) you want to stretch.
3. Specify the base point of displacement.
4. Specify the second point of displacement.

Command line: STRETCH

Trimming and Extending Dimensions

You can trim or extend all forms of linear and ordinate dimensions. To trim or extend a dimension, AutoCAD first creates an example line and then trims or extends the dimension elements to that line. The example line is an invisible line that extends between the two extension line definition points on linear dimensions. On ordinate dimensions, example lines extend from the feature location point to the endpoint of the leader.
To trim or extend an ordinate dimension, AutoCAD moves the feature location point (2) to the boundary edge perpendicular to the measured ordinate (1), so the ordinate value remains unchanged.

To trim a dimension

1. From the Modify menu, choose Trim.
2. Select the object to serve as the cutting edge.
3. Select the line to trim.

Command line: TRIM

Making Dimensions Oblique

AutoCAD creates extension lines perpendicular to the dimension line. However, if the extension lines conflict with other objects in a drawing, you can change their angle. New dimensions are not affected when you make an existing dimension oblique.
To create oblique extension lines
1. From the Dimension menu, choose Oblique.
2. Select the dimension.
3. Enter the angle directly or by specifying two points.

**Command line** DIMEDIT

**Editing Dimension Text**

After you create a dimension, you can edit or replace the dimension text and change dimension text properties and the rotation angle. You can move the text to a new location or back to its home position.

To edit the dimension text position, right-click the dimension and select a text position option from the shortcut menu. You can move the text, with or without a leader, or move the text back to its original (home) position.

You can also use the Properties window (see “Using the Properties Window” on page 260), the Dimensions menu, or the DIMTEDIT and DIMEDIT commands to edit dimension text. The Properties window provides the easiest and most comprehensive method for editing dimension text and text properties. However, the options provided by the Dimension menu or DIMTEDIT and DIMEDIT commands are convenient if you simply want to change text position or edit text on the command line.

**To edit dimension text**
1. Select the dimension.
2. From the Modify menu, choose Properties.
3. In the Properties window under Text, enter the new or edited dimension text in the Text Override box.

**NOTE** Text entered in the Text Override box always overrides the actual dimension measurement, which is shown in the Measurement box. To display the actual dimension measurement, delete the text from the Text Override box.

If you want to add prefixes or suffixes to the dimension measurement, use angle brackets <> to represent the measurement. Enter prefixes before the brackets, and suffixes after the brackets.

You can use the Properties window to edit all text properties, but the Dimension menu provides options that you can use to quickly set dimension alignment.
To set dimension text alignment

1. From the Dimension menu, choose Align Text and then one of the following alignment options:
   - **Home**: Returns dimension text to the position defined by the dimension style assigned to the dimension.
   - **Rotate**: Prompts you to enter an angle to rotate the dimension text.
   - **Left**: Positions dimension text on the left side of the dimension line.
   - **Center**: Centers dimension text.
   - **Right**: Positions dimension text on the right side of the dimension line.

2. Select one or more dimensions, and then press **ENTER**.

**Command line**  DMTEDIT

**Shortcut menu**  Select a dimension, right-click in the drawing area and choose Dim Text Position.

**Editing Dimension Properties**

You can use the Properties window to edit any dimension property, including dimension text. These properties are set by the current dimension style when you create the dimension. You can use the Properties window to view and quickly modify dimension properties, such as linetype, color, text position, and other properties defined by the dimension style. See “Creating Dimension Styles” on page 416.

To edit dimension properties

1. Select the dimension whose properties you want to edit.
2. From the Modify menu, select Properties.
3. In the Properties window, change settings as needed.

**Command line**  PROPERTIES

**Shortcut menu**  Select a dimension, right-click in the drawing area, and choose Properties.

To save modified dimension properties to a new style

1. Select the modified dimension(s), and then right-click.
2. From the shortcut menu, choose Dim Style ➤ Save As New Style.
3. In the New Dimension Style dialog box, enter the new style name, and then choose OK.
Creating Leaders and Annotation

A leader is a line that visually connects annotations to a drawing object. Text is the most common annotation. However, you can attach block references and feature control frames to leaders. (Feature control frames display geometric tolerances. See “Adding Geometric Tolerances” on page 437.)

From any point or object in a drawing, you can create a leader line composed of straight lines or smooth spline curves. When the last leader segment is at an angle greater than 15 degrees from horizontal, a small hook line connects the annotation to the leader.

Formatting Leaders

When you create a leader, its color, lineweight, scale, arrowhead type, size, and other properties are defined by the current dimension style (see “Creating Dimension Styles” on page 416). Unless you create a separate style for leaders, or change leader properties using the Properties window, leader lines have the same properties as dimension lines.

The dimension line properties define the offset of the annotation from the leader endpoint, the position of text annotation relative to the leader, and the point at which the text is attached to the leader. The following illustration shows different text positions.

When you create a leader, you can set annotation, leader line and arrow, and attachment options on the tabs in the Leader Settings dialog box:
Use the Annotation tab to define the annotation type that will be attached to the leader. Options include multiline text, copies of objects, tolerances (feature control frames), and blocks. Use the Copy an Object option to quickly copy existing objects for leader annotation rather than creating new annotation. You can specify multiline text options and indicate whether you want to reuse leader annotation.

Use the Leader Lines and Arrows tab to indicate the leader line type (straight lines or curved spline). You can change the arrowhead and set angle constraints for leader segments. To create leaders quickly, you can specify the number of leader points.

Use the Attachment tab to specify how you want AutoCAD to attach multiline text to leaders. The following illustration shows the attachment options.
To create a simple leader with text

1. From the Dimension menu, choose Leader.
2. Specify the arrow point.
3. Specify the text point, and then press ENTER to enter the leader text.
4. Specify the text width.
5. Enter the first line of text. To enter another line of text, press ENTER, and then enter the text.
6. Press ENTER twice to end the command.

**Command line**  
QLEADER

To change leader settings

1. From the Dimension menu, choose Leader.
2. Press ENTER to display the Leader Settings dialog box, and choose any tab:
   - On the Annotation tab, set the annotation type, mtext, and annotation reuse options.
   - On the Leader Line & Arrow tab, set the leader line and arrow properties.
   - On the Attachment tab, set the multiline text attachment options.

**Command line**  
QLEADER

To create a spline leader with text

1. From the Dimension menu, choose Leader.
2. Press ENTER to display the Leader Settings dialog box, and choose any tab:
   - On the Annotation tab, select MText.
   - On the Leader Line & Arrow tab, select Spline.
3. Select OK.
4. Specify the first, second, and third (optional) leader line points, and then press ENTER.
5. Enter the first line of text. To add additional lines, press ENTER once.
6. Press ENTER twice to end the command.

**Command line**  
QLEADER

The following procedure shows you how to append a feature control frame to a leader. For information about creating feature control frames, see “Adding Geometric Tolerances” on page 437.
To append a feature control frame to a leader

1. From the Dimension menu, choose Leader.
2. Press ENTER to display the Leader Settings dialog box.
3. On the Annotation tab, select Tolerance.
4. Choose OK.
5. Specify the first, second, and third (optional) leader line points, and then press ENTER.
6. In the Geometric Tolerance dialog box, specify the tolerance values and symbols.
7. Choose OK.

Command line  QLEADER

Editing Leaders and Annotations

A leader and its annotation are separate but associated objects. Editing the properties of one object does not affect those of the other. For example, you can change the color of the leader without changing the annotation color. However, if you move the text, the endpoint of the leader moves with it. The endpoint attaches to the left or right side of the annotation depending on the annotation’s position relative to the second-to-last leader point. If you position the annotation to the right of this point, the leader attaches to the right; otherwise, it attaches to the left. You can change the point where the text attaches to the leader by gripping and moving the final leader endpoint, or by changing the attachment setting in the Leader Settings dialog box.

Removing the leader or the annotation from a drawing using the ERASE, BLOCK, WBLOCK, or EXPLODE commands breaks their associativity. You can copy the leader and annotation together in a single operation and maintain their associativity, but copying leader and annotation separately breaks the association. When the association breaks, AutoCAD removes the hook line from the leader.

To edit leader text

- From the Modify menu, choose Text, then edit the text in the Multiline Text Editor. You can also choose Properties on the same menu, and then edit the text in the Text field of the Properties window.

Any modification to the annotation that changes the annotation position or attach point affects the leader’s endpoint position. Rotating the annotation causes the leader hook line (if any) to rotate.
You can use leaders as edges for TRIM and EXTEND, but you cannot trim or extend leaders. To resize a leader, you can stretch or scale it. Scaling changes leader vertex locations, but it does not change characteristics of the leader object that are set by the dimension style.

You can easily create multiple leaders from the same annotation by selecting the leader endpoint and using the Copy options.

To create multiple leaders from the same annotation
1. Select the leader arrowhead grip.
2. At the Command prompt, enter `c` to select the Copy option.
3. Specify the endpoints for the multiple leaders, and then press `ENTER`.

Creating Dimension Styles

Dimension styles control a dimension’s format and appearance. They help you establish and enforce drafting standards for drawings and make changes to dimension formats and behavior easier to implement. A dimension style defines

- The format and position of dimension lines, extension lines, arrowheads, and center marks
- The appearance, position, and behavior of dimension text
- The rules governing where AutoCAD places text and dimension lines
- The overall dimension scale
- The format and precision of primary, alternate, and angular dimension units
- The format and precision of tolerance values

When you create a dimension, AutoCAD uses the dimension style that is current at the time you create the dimension. AutoCAD assigns the default STANDARD style to dimensions until you set another style as current. STANDARD is based on, but does not precisely conform to, American National Standards Institute (ANSI) dimensioning standards. If you start a new drawing and select metric units, ISO-25 (International Standards Organization) is the default dimension style. DIN (German) and JIS (Japanese Industrial Standards) styles are provided in the AutoCAD DIN and JIS drawing templates.
To create a dimension style

1. From the Dimension menu, choose Style. The Dimension Style Manager is displayed. In addition to creating new styles, you can perform many style management tasks. See “Managing Dimension Styles” on page 432.

2. In the Dimension Style Manager, choose New.

3. In the New Dimension Style dialog box, enter the new style name.

4. Select the style you want to use as a start point for the new style.
   If you have not created styles, you start with STANDARD. The starting style and the new style are not linked.

5. Indicate the dimension type for which you want to use the new style.
   All Dimension Types is the default. You can also specify settings to be used for particular dimension types. For example, suppose the text color for the STANDARD style is black, but you want the text to be blue only for diameter dimensions. Under Start With, select STANDARD, and under Use For, select Diameter. New Style Name becomes unavailable because you are defining a substyle of STANDARD. After you change the text color to blue (using the steps that follow), Diameter is displayed as a substyle under STANDARD in the Dimension Style Manager. Whenever you use the STANDARD style for diameter dimensions, the text will be blue. For all other dimension types, the text will be black.

6. Choose Continue.

7. In the New Dimension Style dialog box, choose any of the following tabs to enter dimension settings for the new style:
   - **Lines and Arrows**: Sets the appearance and behavior of the dimension lines, extension lines, arrowheads, center marks, and centerlines (see “Formatting Dimension Lines and Arrows” on page 418).
   - **Text**: Sets the dimension text appearance, placement, alignment, and movement (see “Formatting Dimension Text” on page 419).
   - **Fit**: Sets options governing where AutoCAD places dimension lines, extension lines, and text. Also defines the overall dimension scale (see “Fitting Dimension Text and Arrowheads” on page 421).
   - **Primary Units**: Sets the format and precision of linear and angular dimension units (see “Formatting Primary Dimension Units” on page 422).
   - **Alternate Units**: Sets the alternate unit format and precision (see “Adding Alternate Dimension Units” on page 425).
   - **Tolerances**: Sets lateral tolerance values and precision (see “Adding Tolerances to Dimensions” on page 426).

8. When you finish making changes on the tabs of the New Dimension Style dialog box, choose OK, and then close the Dimension Style Manager.

**Command line** DIMSTYLE
Formatting Dimension Lines and Arrows

Use the Lines and Arrows tab in the New Dimension Style dialog box to format dimension lines, extension lines, arrowheads, and center marks.

You can set dimension line color and lineweight, specify spacing for baseline dimensions (see “Creating Baseline and Continued Dimensions” on page 403), and extend dimension lines beyond tick, oblique-stroke, and other similar arrowhead types.

![Extension beyond tick](image)

You can suppress the first or second dimension line. AutoCAD determines the first and second dimension lines from the order in which you set the dimension points. For angular dimensions, the second dimension line is counterclockwise from the first. If you create a dimension by selecting an object, AutoCAD determines the first and second dimension lines based on the selected geometry.

You can also set the extension line color and lineweight, and suppress one or both extension lines. You can extend extension lines above the dimension lines and offset them from the dimension origin points, as shown in the following illustration.
The arrowhead lists provide a variety of arrowhead types that you can use for dimension lines and leaders, including arrowheads, dots, oblique strokes, and ticks. If you change the first arrowhead, AutoCAD changes the second automatically. If you want a different second arrowhead, select one in the 2nd box. You can change the arrowhead size. You can also create and use your own arrowhead symbol. See “Creating Arrowheads” on page 436.

You can change center mark settings, and change the center mark size. None turns off center marks. Marks displays center marks. Lines displays centerlines. (See “Creating Center Marks and Centerlines” on page 401.)

**Formatting Dimension Text**

Use the Text tab in the New Dimension Style dialog box to set text appearance, placement, and alignment.

![New Dimension Style Sample](image)
You can assign text styles to dimension text (see “Working with Text Styles” on page 370). The Text Style list shows the text styles available in the drawing. To create or edit a text style, select the button next to the Text Style list to display the Text Style dialog box. See “Creating and Modifying Text Styles” on page 371.

You can also set text color and height and indicate whether you want a frame drawn around the text. If a fixed text height is set in the text style, that height overrides the text height set here in the New Dimension Style dialog box. Make sure the text height in the text style is set to 0 if you want to set it on the Text tab.

Text placement options govern the placement of text relative to dimension lines, extension lines, and dimensioned objects. When you select an option, the sample image displays the result.

The Vertical options set the position of the dimension text vertically.

- **Centered**: Places the text centered within the dimension line.
- **Above**: Places the dimension text above the dimension line when the text is parallel to the dimension line. Both settings are based on an X and Y orientation.
- **Outside**: Places the dimension text to the outside of the dimensioned object, regardless of its X and Y orientation.
- **JIS**: (Japanese Industrial Standards) Always positions text above the dimension line, even if the text is not parallel to the dimension line.

**NOTE** The vertical position descriptions are based on horizontal dimensions.

The Horizontal options set the position of the dimension text horizontally.

- **Centered**: Centers the dimension text between the extension lines.
- **1st Extension Line**: Left-justifies the text at the first extension line along the dimension line.
- **2nd Extension Line**: Right-justifies the text at the second extension line along the dimension line.
- **Over 1st Extension Line**: Positions the text over or along the first extension line.
- **Over 2nd Extension Line**: Positions the text over or along the second extension line.
Text alignment options adjust the rotation of the text relative to the dimension line.

- **Horizontal**: Keeps the text aligned with the X axis, regardless of the dimension line angle.
- **Aligned with Dimension Line**: Aligns the text with the dimension line.
- **ISO Standard**: Aligns dimension text with the dimension line when text is within the extension lines; positions text horizontally when the text is outside the extension lines.

### Fitting Dimension Text and Arrowheads

When you create a dimension, many factors determine how AutoCAD positions dimension text and arrowheads. If possible, AutoCAD automatically places both between the extension lines. However, if space is not sufficient to do this, AutoCAD follows rules set on the Fit tab of the New Dimension Style dialog box.

The Fit options set priorities for moving text and arrowheads when space is not available to fit both within the extension lines. The following illustrations show different dimension text and arrowhead positions.
Text Placement options set rules governing the placement of dimension text. The rules are applied when AutoCAD must place text outside the extension lines or when you move the text outside the extension lines manually. You can have text placed beside or above the dimension line. If placed above, you can display a leader from the dimension line to the text.

Overall Scale sets the scale factor for all dimension style settings that specify size, distance, or spacing, including text and arrowhead size. The overall scale does not affect measured distances, coordinates, angles, or tolerances. Its default value is 1.0. Enter larger values to increase the size of dimensions; smaller values reduce the size. Scale Dimension to Layout determines a scale factor based on the scaling between the current model viewport and the layout. See “Setting Dimension Scale” on page 428.

The following two options fine-tune the dimension fit:

- **Place Text Manually When Dimensioning**: Sets the location you specify for dimension text when you create a dimension.
- **Always Draw a Dim Line between Ext Lines**: Places a dimension line between extension lines, even if arrowheads and text are outside.

### Formatting Primary Dimension Units

AutoCAD provides many ways to format dimension units. You can set the unit type, precision, fraction format, and decimal format. You can also add prefixes and suffixes. For example, you can add a diameter symbol as a prefix to a measurement or add a unit abbreviation, such as $\text{mm}$, as a suffix. You set the format for primary dimension units on the Primary Units tab in the New Dimension Style dialog box.
Under Linear Dimensions, you can set the format for linear, aligned, radius, diameter, ordinate, and nonangular baseline and continued dimensions.

- **Units Format**: Sets the unit format—Scientific, Decimal, Engineering, Architectural, Fractional, Windows Desktop. (Windows Desktop uses the settings on the Windows Regional Settings control panel.) The following illustrations show examples of each format.

  | 1.00E+00 | 25.4 | 1.00" |
  | Scientific | Decimal | Engineering |

  | 1'-0" | 31/32 |
  | Architectural | Fractional |

- **Precision**: Sets the number of decimal places for units and shows the format in which values are displayed, depending on the unit type.

- **Fraction Format**: Sets the format for fractional units Diagonal, Horizontal, or Not Stacked.
- **Decimal Separator:** Sets the decimal separator—period (.), comma (,) or space ( )—unless you select Windows Desktop units, in which case AutoCAD uses the Decimal Symbol setting in the Regional Settings control panel.

- **Round Distances To:** Rounds measurements to the specified value. For example, if you enter .05 as a round-off value, AutoCAD rounds 0.06 to 0.10, and 0.008 to 0.01. You can enter a rounding value up to five decimal places. The decimal precision of your rounding value should equal or be less than your Precision value.

- **Prefix:** Specifies a prefix for the dimension measurement. If you enter a prefix, it replaces the radius and diameter prefixes that AutoCAD automatically adds to radius and diameter dimensions. You can use control codes and special characters to enter special prefix symbols.

- **Suffix:** Specifies a suffix for the dimension measurement. You can use control codes and special characters to enter special suffix symbols.

- **Linear Scale Factor:** Multiplies the measurement value of linear dimensions (linear, aligned, radius, diameter, ordinate, baseline, continued) by the value entered. For example, if you set the scale factor to 2.0, AutoCAD dimensions two-unit segments as 4.0 units. If you set it to .25, AutoCAD dimensions the two-inch segment as 0.5 units. See “Rounding Off Dimension Values” on page 428.

- **Scale Dimension to Layout:** Applies the linear scale factor only to dimensions in layouts. See “Setting Dimension Scale” on page 428.

The following table shows control codes and special characters used to create common dimension prefixes and suffixes. See “Using Control Codes and Special Characters” under “TEXT” in the Command Reference.

<table>
<thead>
<tr>
<th>Name</th>
<th>Symbol</th>
<th>Standard AutoCAD fonts</th>
<th>Unicode</th>
</tr>
</thead>
<tbody>
<tr>
<td>Degrees</td>
<td>°</td>
<td>%%d</td>
<td>\U+00B0</td>
</tr>
<tr>
<td>Diameter</td>
<td>Ø</td>
<td>%%c</td>
<td>\U+2205</td>
</tr>
<tr>
<td>Tolerance</td>
<td>±</td>
<td>%%p</td>
<td>\U+00B1</td>
</tr>
<tr>
<td>Percent</td>
<td>%</td>
<td>%%%</td>
<td></td>
</tr>
</tbody>
</table>

You can set the format and precision for angular dimensions. Angular dimension options include Decimal Degrees, Deg/Min/Sec (degrees, minutes, seconds), Grads, and Radians.

You can suppress leading and trailing zeros for both linear and angular dimensions. See “Suppressing Zeros in Dimension Units” on page 427.
Adding Alternate Dimension Units

Alternate dimension units communicate the dimension in an additional measurement system. They commonly display the metric equivalent for imperial dimensions, or the imperial version for metric dimensions. Alternate dimension units are displayed in square brackets [ ] next to the primary units in the dimension text. You use the Alternate Units tab in the New Dimension Style dialog box to format alternate dimension units.

When you select Display Alternate Units, AutoCAD displays alternate units for dimensions. Setting the units format, precision, rounding, prefixes, suffixes, and zero suppression for alternate dimension units is the same as setting them for primary units (see “Formatting Primary Dimension Units” on page 422). However, two settings are unique to alternate units:

- **Multiplier for Alternate Units**: Multiplies the primary unit by the number you enter to create the alternate units. The default value, 25.4, is the multiplier for converting inches to millimeters. If you dimension a one-inch line, the dimension displays 1.00 [25.40], and a two-inch dimension displays 2.00 [50.80] or, with inch and millimeter suffixes, 2.00” [50.80mm].

- **Placement**: Sets the alternate unit placement, either after or below the primary units. If you select below, AutoCAD places the primary units above the dimension line and the alternate units below it.
Adding Tolerances to Dimensions

Tolerances show the range within which a dimension can vary. You can add tolerances as dimension text, using the options on the Tolerances tab to format them. These tolerances differ from geometric tolerances, which are displayed in feature control frames. For information about geometric tolerances, see “Adding Geometric Tolerances” on page 437.

Under Tolerance Format, set the following tolerance display options:

- **Method**: Sets the tolerance method. None turns off display of tolerances. Use Symmetrical when the tolerance plus or minus values are the same, and use Deviation when plus or minus values differ. Limits incorporates plus or minus values into the dimension value and displays the maximum dimension over the minimum. Basic draws a box around the dimension text, a format often used to indicate theoretically exact dimensions. Basic is also controlled by the Draw Frame Around Text option on the Text tab. Changing one of these options changes the other.

- **Precision**: Sets the number of decimal places for tolerance values.
- **Upper Value**: Sets the upper value for deviation and limits methods. AutoCAD also uses this value for symmetrical tolerances.
■ **Lower Value:** Sets the lower value for deviation and limits methods.
■ **Scale Factor for Height:** Sets the tolerance text height as a scale factor of the primary measurement text height.
■ **Vertical Position:** Sets vertical position for symmetrical and deviation tolerances. **Top** aligns the tolerance text with the top of the dimension text, **Middle** with the middle, and **Bottom** with the bottom of the dimension text.

### Suppressing Zeros in Dimension Units

You can suppress the display of leading and trailing zeros in dimension units. You can also suppress the display of feet and inches when their values are zero. Zero Suppression options are provided on the Primary Units, Alternate Units, and Tolerances tabs of the New, Modify, or Override Dimension Style dialog boxes.

To suppress leading and trailing zeros, select the appropriate option under **Zero Suppression**.

■ If you suppress leading zeros, 0.500 becomes .500.
■ If you suppress trailing zeros, 0.500 becomes 0.5.
■ If you suppress leading and trailing zeros, 0.5000 becomes .5 and 0.0000 becomes 0.

If your drawing units are set to architectural or fractional, you can suppress the display of zero feet and zero inches. If you suppress feet, any dimension less than a foot shows only the inches portion. For example, 0'-6" becomes 6". If you suppress inches, 1'-0" becomes 1'.

If feet are included with a fractional inch, the number of inches is indicated as zero, no matter which option you select. For example, AutoCAD displays 4'-3/4" to 4'-0 3/4". The following table shows the effect of each suppression option in architectural units.

<table>
<thead>
<tr>
<th>Option</th>
<th>Effect</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>No options selected</td>
<td>Includes zero feet and zero inches</td>
<td>0'-0 1/2&quot;, 0'-6&quot;, 1'-0&quot;, 1'-0 3/4&quot;</td>
</tr>
<tr>
<td>0 Inches selected</td>
<td>Suppresses zero inches (includes zero feet)</td>
<td>0'-0 1/2&quot;, 0'-6&quot;, 1'</td>
</tr>
<tr>
<td>0 Feet selected</td>
<td>Suppresses zero feet (includes zero inches)</td>
<td>1/2&quot;, 6&quot;, 1'-0&quot;, 1'-0 3/4&quot;</td>
</tr>
<tr>
<td>0 Feet and 0 Inches selected</td>
<td>Suppresses zero feet and zero inches</td>
<td>1/2&quot;, 6&quot;, 1'</td>
</tr>
</tbody>
</table>

---

Creating Dimension Styles | 427
Rounding Off Dimension Values

You can round off all dimension values except tolerances. For example, if you specify a round-off value of 0.25, all distances are rounded to the nearest 0.25 unit. The number of digits displayed after the decimal point depends on the precision set for primary and alternate units and lateral tolerance values. The following illustration provides rounding examples.

![Rounding examples](image)

**NOTE** Rounding only affects the display of your dimensions; it does not change the actual measurement.

Setting Dimension Scale

When you plot your drawings, you prepare layouts containing different views of your model geometry. You usually set views to different scales to show drawing components in varying levels of detail. However, you usually display dimensions at the same general scale in all views. To do this, you can change the overall dimension scale, or change the linear scale. The following table shows the components involved in determining the dimension scale.

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
<th>Set on</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dimension geometry</td>
<td>All sized dimension elements: text height, arrow size, center mark size, gaps, offsets, and spacing.</td>
<td>New, Modify, Override Dimension Style dialog box.</td>
</tr>
<tr>
<td>Overall dimension scale</td>
<td>Scales dimension geometry. Changes the size of the dimension, but does not change the dimension measurement value.</td>
<td>Fit tab of the New, Modify, or Override Dimension Style dialog box. System variable: DIMSCALE.</td>
</tr>
<tr>
<td>Linear scale</td>
<td>Scales the dimension measurement of linear dimensions. Primarily used when creating dimensions in layouts to compensate for layout scale.</td>
<td>Primary Units tab of the New, Modify, or Override Dimension Style dialog box. System variable: DIMLFAC.</td>
</tr>
</tbody>
</table>

428 | Chapter 12  Creating Dimensions
Creating Dimension Styles

Setting Overall Dimension Scale

The overall dimension scale is set on the Fit tab of the New, Modify, or Override Dimension Style dialog boxes (see “Fitting Dimension Text and Arrowheads” on page 421). The scale changes the size of the dimension geometry relative to the drawing. AutoCAD multiplies the geometric dimension values, such as text height, arrowhead size, offsets and gaps, by the overall scale value. In general, you should set the dimension geometric values to their plotted size, and use the overall scale to compensate for layout scaling. AutoCAD does not apply the overall scale to tolerance values, coordinates, or angles.

The following table shows the relationship of the dimension scale factor and the plot scale.

<table>
<thead>
<tr>
<th>Dimension text height</th>
<th>Overall Dimension scale</th>
<th>Plot scale (plotted units: drawing units)</th>
<th>Plotted text height</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.25</td>
<td>1</td>
<td>1:1</td>
<td>0.25</td>
</tr>
<tr>
<td>0.25</td>
<td>1</td>
<td>1:2</td>
<td>0.125</td>
</tr>
<tr>
<td>0.25</td>
<td>2</td>
<td>1:2</td>
<td>0.25</td>
</tr>
<tr>
<td>0.25</td>
<td>1</td>
<td>2:1</td>
<td>0.5</td>
</tr>
</tbody>
</table>

The following formula summarizes the relationship:

\[
\text{Plotted Height} = \text{Text Height} \times \frac{\text{Plot Units}}{\text{Drawing Units}} \times \text{Overall Dimension Scale}
\]

When you set the overall dimension scale, you can enter a value or you can choose Scale Dimensions to Layout to have AutoCAD scale dimensions based on the scale of the layout view. If you work directly in a layout, AutoCAD uses the default scale of 1.0. If you choose to scale in layouts only, AutoCAD computes the scale automatically, and the overall scale option is not available.

The dimension scale is independent of the drawing scale, although they should be identical. For more information about the drawing scale, see “Setting Grid Limits” on page 69. Changing the drawing scale might cause dimension text and arrowheads to appear at inappropriate sizes. Set text height and arrowhead size to the actual sizes you want. AutoCAD multiplies these values by the overall dimension scale.
Creating Dimensions in Model Space and Paper Space

You can draw dimensions in layouts (created in paper space) and in model space. However, if the geometry you’re dimensioning is in model space, draw dimensions in model space because AutoCAD places the definition points in the space where the geometry is drawn and you can edit them together.

If you draw a dimension in a layout that describes geometry in your model, the layout dimension does not change when you use editing commands or change the magnification of the display in the model space viewport. The location of the layout dimensions also stays the same when you change a view from a layout to model space.

If you dimension in layouts, you can set the linear dimension scale on the Primary Units tab of the Dimension Style dialog box (DIMLFAC system variable) to less than zero, the distance measured is multiplied by the scale’s absolute value. If you dimension in model space, the value of 1.0 is used even if DIMLFAC is less than zero. In layouts, AutoCAD computes a value for DIMLFAC if you change the variable from the DIM prompt and select the Viewport option. To do this, enter DIM at the command prompt, then enter DIMLFAC. Select the Viewport option, and then select the viewport you want to scale. AutoCAD calculates the scaling of model space to layouts and assigns the negative of this value to DIMLFAC.

Using the DIMLFAC system variable, you can adjust the dimension length scale factor to the zoom scale factor of a model space viewport automatically. This is possible only from a layout, and you must enter DIMLFAC from the DIM command. This scaling method does not work for ordinate dimensions.

To set dimension scale in a layout

1. Choose a layout tab.
2. At the Command prompt, enter dimlfac.
3. At the prompt, enter a new dimension scale.

To dimension in floating viewports

1. Set the current layer to one that is visible only in the chosen viewport.
2. From the Dimension menu, choose Style.
3. In the Dimension Style Manager, select New, Modify, or Override, depending on whether you are creating a new dimension style or modifying or overriding an existing one.
4. In the Dimension Style Manager, choose the Fit tab.
5 Under Scale for Dimension Features, select Dimension to Layout.
6 Dimension the object.

**NOTE** Before you add dimensions, be sure to zoom to the correct scale. See “Scaling Views Relative to Paper Space” on page 538.

AutoCAD computes a scale factor based on the scaling between the layout and the current model space viewport. You may prefer to work in model space but use the dimensioning capabilities of layouts. The following procedures explain how to do this.

**To dimension in model space for layouts in paper space**
1 From the Dimension menu, choose Style.
2 In the Dimension Style Manager, select New or Modify, depending on whether you are creating a new style or modifying an existing one.
3 In the Dimension Style Manager, choose the Fit tab.
4 Under Overall Scale, enter a value for the overall scale.
5 Choose OK to exit each dialog box.
6 Add the dimensions to the drawing using the scale you defined.
   When you’re ready to lay out or plot your drawing, continue with the following procedure.

**To complete the dimensions in layouts**
1 Choose a layout tab.
2 Switch to a model space viewport.
   For more information about model space viewports, see “Creating Nonrectangular Viewports” in chapter 15, “Creating a Layout to Plot.”
3 From the Dimension menu, choose Style.
4 In the Dimension Style Manager, select New or Modify, depending on whether you are creating a new style or modifying an existing one.
5 In the Dimension Style Manager, choose the Fit tab.
6 Under Scale for Dimension Features, select Dimension to Layout.
7 Choose OK to close each dialog box.
8 From the Dimension menu, choose Update, and then select the dimensions that apply to your current view.
Managing Dimension Styles

You can use the Dimension Style Manager to perform many dimension style management tasks:

- Create new dimension styles (see “Creating Dimension Styles” on page 416)
- Modify existing dimension styles
- Set the current style
- View a drawing’s dimension styles and dimension style properties
- Preview dimension styles
- Compare two dimension styles, or list all the properties for a style
- Rename dimension styles
- Delete dimension styles

To set the current dimension style

1. From the Dimension menu, choose Style.
2. In the Dimension Style Manager, select a style and choose Set Current. You can also double-click the style to make it current.

   **Command line**   DIMSTYLE

To modify a dimension style

1. From the Dimension menu, choose Style.
2. In the Dimension Style Manager, select the style you want to modify, and then choose Modify.
In the Modify Dimension Style dialog box, choose any of the following tabs to modify the style settings:

- **Lines and Arrows**: Modifies the appearance and behavior of the dimension lines, extension lines, arrowheads, center marks, and centerlines (see “Formatting Dimension Lines and Arrows” on page 418).
- **Text**: Modifies the dimension text appearance, placement, alignment, and movement (see “Formatting Dimension Text” on page 419).
- **Fit**: Sets options governing where AutoCAD places dimension lines, extension lines, and text and defines the overall dimension scale (see “Fitting Dimension Text and Arrowheads” on page 421).
- **Primary Units**: Sets the format and precision of linear and angular dimension units (see “Formatting Primary Dimension Units” on page 422).
- **Alternate Units**: Modifies the alternate unit format and precision (see “Adding Alternate Dimension Units” on page 425).
- **Tolerances**: Modifies lateral tolerance values and precision (see “Adding Tolerances to Dimensions” on page 426).

Choose OK, and then choose Close.

Command line DIMSTYLE

To compare dimension styles

1. From the Dimension menu, choose Style.
2. In the Dimension Style Manager, choose Compare.

3. In the Compare Dimension Styles dialog box, select the dimensions you want to compare.

AutoCAD displays the properties that differ between the two styles. If you select the same style, AutoCAD displays all the properties for that style.
4 After the comparison you can click the Copy to Clipboard button to copy the comparison to the Clipboard. You can then paste the comparison to another Microsoft® Windows® program for further formatting. For example, you can select a cell in a Microsoft Excel sheet and paste the style comparison information into a worksheet.

5 Choose Close to exit each dialog box.

Command line  DIMSTYLE

Renaming and Deleting Styles

You can easily rename or delete dimension styles using the shortcut menu in the Dimension Style Manager.

To rename a dimension style

1 From the Dimension menu, choose Style.
2 In the Dimension Style Manager, right-click the style under the Styles list and choose Rename.
3 Enter the new style name, and then press ENTER.

To delete a dimension style

1 From the Dimension menu, choose Style.
2 In the Dimension Style Manager, right-click the style you want to delete in the Styles list and choose Delete (or select the style and press DELETE).

You cannot delete dimension styles if
- The style is the current style
- Dimensions in the drawing use the style
- The style has substyles associated with it

Applying Styles to Dimensions

AutoCAD assigns a style to all dimensions. The style assigned is the one set current in the Dimension Style Manager. STANDARD is the default style. If you create dimensions in one style and later want to assign a different style, you apply a dimension style to the dimensions.

To apply a dimension style to a dimension

1 Select the dimension whose style you want to change.
2 Right-click and choose Dim Style, and then choose the style to assign to the dimension.

Command line  DIMSTYLE
Overriding Dimension Styles

You can define dimension style overrides for individual dimensions, or for the current dimension style. For individual dimensions, you may want to create overrides to suppress a dimension’s extension lines or modify text and arrowhead placement so that they do not overlap drawing geometry without creating a different dimension style. (To create overrides for individual dimensions, see “Editing Dimensions” on page 406 and “Editing Dimension Properties” on page 411.)

You can also set up overrides to the current dimension style. All dimensions you create in the style include the overrides until you delete the overrides, save the overrides to a new style, or set another style current.

To create dimension style overrides

1. From the Dimension menu, choose Style.
2. In the Dimension Style Manager, choose Override.
3. In the Override Current Style dialog box, enter the style overrides, and then choose OK.

AutoCAD displays <style overrides> below the dimension style name. After you create dimension style overrides, you can continue to modify dimension styles, compare them with other dimension styles, or delete or rename the overrides.

Managing Dimension Style Overrides

You can do anything with dimension style overrides that you can do with the dimension style. Use it as a base for a new style, or modify, rename, delete, or compare the overrides to other styles. You cannot set the overrides current because they are already current. If you set another style current, your overrides are discarded. However, you can rename them to a new style, or save the settings to the current style.

To save overrides to the current style

1. In the Dimension Styles Manager, right-click <style overrides> in the Styles list.
2. From the shortcut menu, choose Save to Current Style.
Creating Arrowheads

Dimension line arrowheads are AutoCAD blocks. (See chapter 13, “Using Blocks and External References” on page 443.) AutoCAD provides 19 arrowheads that you can use, but you can also create and use your own arrowhead blocks. AutoCAD inserts the block in the arrowhead location and sets the object’s X and Y scale factors to arrowhead size × overall scale. To trim the dimension line, AutoCAD inserts the rightmost block with a zero rotation angle for horizontal dimensions and rotates the leftmost block 180 degrees about its insertion point. If you use paper space scaling, AutoCAD computes the scale factor before applying it to the arrowhead size value.

The following example shows how to create a three-stroke arrowhead. Setting Snap mode to half a drawing unit and setting the grid to one drawing unit makes block creation easier. You create the block for insertion as the right arrowhead of a horizontal dimension line.

The illustration shows a right-angle (or three-stroke) arrowhead with a one-unit grid for clarity. The block’s insertion base point is at the point where the dimension line and the extension line intersect (in the illustration, at the tip of the arrowhead).

The dimension line stops arrowhead size × overall scale drawing units away from the extension line. Consequently, the block consists of an arrowhead and a short horizontal tail line connecting to the dimension line.

To create your own arrowhead symbol

1. Draw the arrowhead so that it measures exactly one drawing unit from the insertion base point at the tip of the arrowhead to the end of the tail.

2. From the Draw menu, choose Block ➤ Make.

3. Enter a block name for the symbol.

4. For the insertion base point of the block, specify the point you want placed at the intersection of the dimension line and the extension line (where the tip of the default arrowhead would be).

5. Select the objects for inclusion in the block.

Command line  BLOCK
To use your own arrowhead symbol

1. From the Dimension menu, choose Style.
2. In the Dimension Style Manager, choose New or Modify, depending on whether you are using the arrowhead for a new dimension style, or modifying an existing dimension style.
3. In the New Dimension Style or Modify Dimension Style dialog box under Arrowheads, select User Arrow.
   The Select Custom Arrow Block dialog box displays a list of blocks within the drawing.
4. In the Select Custom Arrow Block dialog box, select the arrowhead from the list.
5. Choose OK to complete the modification.

To use a custom arrowhead block for the second arrowhead, repeat steps 3 and 4, choosing User Arrow in the 2nd arrowhead list.

**Adding Geometric Tolerances**

Geometric tolerancing shows deviations of form, profile, orientation, location, and runout of a feature. You add geometric tolerances in feature control frames. These frames contain all the tolerance information for a single dimension.

You can copy, move, erase, scale, and rotate feature control frames. You can snap to them using the object snap modes. You can use DDEDIT to edit feature control frames, or you can edit them with grips (see “Editing with Grips” on page 246).
A feature control frame consists of at least two compartments. The first contains a geometric characteristic symbol that represents the geometric characteristic to which a tolerance is being applied, for example, form, orientation, or runout. Form tolerances control straightness, flatness, circularity, cylindricity, and profiles of line and surface. In the illustration, the characteristic is position.

The second compartment contains the tolerance value. Where applicable, the tolerance value is preceded by a diameter symbol and followed by a material condition symbol.

**To add geometric tolerances**

1. From the Dimension menu, choose Tolerance.
2. In the Geometric Tolerance dialog box, enter the tolerance values and modifying symbols.

   - Under Sym, click the first or second box to select a symbol for the first or second tolerance symbol, and then choose the symbol you want displayed in the Symbol dialog box.

---

**Definitions**

- Geometric symbol
- Primary datum reference
- Secondary datum reference
- Tertiary datum reference
- Diameter symbol
- Second line of tolerance symbols
- Material condition symbol
- First tolerance value
- Second tolerance value

---

438 | Chapter 12  Creating Dimensions
Under Tolerance 1, select Dia to insert a diameter symbol.
Under Value, enter the first tolerance value.
Choose MC to add a material condition.
In the Material Condition dialog box, double-click a material condition symbol to insert it.
Add a second tolerance value (optional) in the same way as the first tolerance value.
Now add the datum reference letters and their modifying symbols (optional).

3 Choose OK.

To add datum reference letters
1 In the Geometric Tolerance dialog box under Datum 1, enter the primary datum reference letter.
2 Choose MC to insert a material condition symbol for the primary datum reference.
3 In the Material Condition dialog box, double-click a material condition symbol to insert it.
4 Add secondary and tertiary datums and modifying symbols in the same way.
Now add a projected tolerance zone (optional).
5 In the Height box, enter a height. Select Projected Tolerance Zone to insert the $\circ$ symbol.
6 Choose OK.
7 In the drawing, specify a location for the feature control frame.
8 Choose OK to close each dialog box.

Command line  TOLERANCE

Material Conditions

Material conditions apply to features that can vary in size. At maximum material condition ($\circ$, also known as MMC), a feature contains the maximum amount of material stated in the limits. At MMC, a hole has a minimum diameter, whereas a shaft has a maximum diameter. At least material condition ($\circ$, also known as LMC), a feature contains the minimum amount of material stated in the limits. At LMC, a hole has maximum diameter, whereas a shaft has minimum diameter. The third material feature condition, regardless of Feature Size ($\circ$, also known as RFS), means a feature can be any size within the stated limits.
**Datum Reference Frames**

The tolerance values in the feature control frame are followed by up to three optional datum reference letters and their modifying symbols. A datum is a theoretically exact point, axis, or plane from which you make measurements and verify dimensions. Usually, two or three mutually perpendicular planes perform this task best. These are jointly called the datum reference frame.

The following illustration shows a datum reference frame verifying the dimensions of the part.

![Datum Reference Frame Illustration](image)

**Projected Tolerance Zones**

Projected tolerances are specified in addition to positional tolerances to make the tolerance more specific. For example, projected tolerances specify the perpendicularity tolerance zone of an embedded part.

![Projected Tolerance Zones](image)

The symbol for projected tolerance ((pat) is preceded by a height value, which specifies the minimum projected tolerance zone. The projected tolerance zone height and symbol appear in a frame below the feature control frame.
Composite Tolerances

A composite tolerance specifies two tolerances for the same geometric characteristic of a feature or features that have different datum requirements. One tolerance relates to a pattern of features and the other tolerance to each feature within the pattern. The individual feature tolerance is more restrictive than the pattern tolerance.

In the illustration, where datums A and B intersect is the datum axis, the point from which the position of the pattern is calculated. A composite tolerance could specify both the diameter of the pattern of holes and the diameter of each individual hole.

When you add composite tolerances to a drawing, you create the first line of a feature control frame and then choose the same geometric characteristic symbol for the second line of the feature control frame. AutoCAD extends the geometric symbol compartment over both lines. You can then create a second line of tolerance symbols.

To add composite tolerances

1. From the Dimension menu, choose Tolerance.
2. In the Geometric Tolerance dialog box, choose Sym.
3. In the Symbol dialog box, choose the composite tolerance symbol.
4 Choose OK.
5 In the Geometric Tolerance dialog box, create the first and second tolerance symbol lines.
6 In the Geometric Tolerance dialog box, on the second line of the feature control frame, choose Sym.
7 In the Symbol dialog box, choose the same geometric characteristic symbol as for the first line.
8 In the Geometric Tolerance dialog box under Tolerance 1, enter the tolerance value and any modifying symbols.
9 Choose OK, and then specify the location of the feature control frame in the drawing.

**Command line** TOLERANCE